GPIB Hardware Guide
Worldwide Technical Support and Product Information

ni.com

National Instruments Corporate Headquarters
11500 North Mopac Expressway Austin, Texas 78759-3504 USA Tel: 512 683 0100

Worldwide Offices

Australia 1800 300 800, Austria 43 662 457990-0, Belgium 32 (0) 2 757 0020, Brazil 55 11 3262 3599,
Canada 800 433 3488, China 86 21 5050 9800, Czech Republic 420 224 235 774, Denmark 45 45 76 26 00,
Finland 358 (0) 9 725 72511, France 01 57 66 24 24, Germany 49 89 7413130, India 91 80 41190000,
Israel 972 3 6393737, Italy 39 02 41309277, Japan 0120-527196, Korea 82 0 11805 8197,
Lebanon 961 (0) 1 33 28 28, Malaysia 1800 887710, Mexico 01 800 010 0793, Netherlands 31 (0) 348 433 466,
New Zealand 0800 553 322, Norway 47 (0) 66 90 76 60, Poland 48 22 3390150, Portugal 351 210 311 210,
Russia 7 495 783 6851, Singapore 1800 226 5886, Slovenia 386 3 425 42 00, South Africa 27 0 11 805 8197,
Spain 34 91 640 0085, Sweden 46 (0) 8 587 895 00, Switzerland 41 56 2005151, Taiwan 886 02 2377 2222,
Thailand 662 278 6777, Turkey 90 212 279 3031, United Kingdom 44 (0) 1635 523545

For further support information, refer to the Technical Support and Professional Services appendix. To comment on National Instruments documentation, refer to the National Instruments Web site at ni.com/info and enter the info code feedback.

© 2001–2008 National Instruments Corporation. All rights reserved.
Warranty
The GPIB hardware is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

Except as specified herein, National Instruments makes no warranties, express or implied, and specifically disclaims any warranty of merchantability or fitness for a particular purpose. Customer’s right to recover damages caused by fault or negligence on the part of National Instruments shall be limited to the amount therefore paid by the customer. National Instruments will not be liable for damages resulting from loss of data, profits, use of products, or incidental or consequential damages, even if advised of the possibility thereof. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National Instruments Corporation.

National Instruments respects the intellectual property of others, and we ask our users to do the same. NI software is protected by copyright and other intellectual property laws. Where NI software may be used to reproduce software or other materials belonging to others, you may use NI software only to reproduce materials that you may reproduce in accordance with the terms of any applicable license or other legal restriction.

Trademarks
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section on ni.com/legal for more information about National Instruments trademarks.

The ExpressCard™ word mark and logos are owned by PCMCIA and any use of such marks by National Instruments is under license. Other product and company names mentioned herein are trademarks or trade names of their respective companies.

Members of the National Instruments Alliance Partner Program are business entities independent from National Instruments and have no agency, partnership, or joint-venture relationship with National Instruments.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file on your media, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR EVENT ON THE PART OF THE USER OR APPLICATION DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE, TO AVOID DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.
Compliance

Compliance with FCC/Canada Radio Frequency Interference Regulations

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect wireless communications from interference. The FCC places digital electronics into two classes. These classes are known as Class A (for use in industrial-commercial locations only) or Class B (for use in residential or commercial locations). All National Instruments (NI) products are FCC Class A products. Depending on where it is operated, this Class A product could be subject to restrictions in the FCC rules. (In Canada, the Department of Communications (DOC), of Industry Canada, regulates wireless interference in much the same way.) Digital electronics emit weak signals during normal operation that can affect radio, television, or other wireless products. All Class A products display a simple warning statement of one paragraph in length regarding interference and undesired operation. The FCC rules have restrictions regarding the locations where FCC Class A products can be operated. Consult the FCC Web site at www.fcc.gov for more information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the instructions in this manual and the CE marking Declaration of Conformity*, may cause interference to radio and television reception. Classification requirements are the same for the Federal Communications Commission (FCC) and the Canadian Department of Communications (DOC).
Changes or modifications not expressly approved by NI could void the user’s authority to operate the equipment under the FCC Rules.

Class A
Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user is required to correct the interference at their own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations. Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Compliance with EU Directives
Users in the European Union (EU) should refer to the Declaration of Conformity (DoC) for information* pertaining to the CE marking. Refer to the Declaration of Conformity (DoC) for this product for any additional regulatory compliance information. To obtain the DoC for this product, visit ni.com/certification, search by model number or product line, and click the appropriate link in the Certification column.

* The CE marking Declaration of Conformity contains important supplementary information and instructions for the user or installer.
Conventions

The following conventions are used in this manual:

»

The » symbol leads you through nested menu items and dialog box options to a final action. The sequence File » Page Setup » Options directs you to pull down the File menu, select the Page Setup item, and select Options from the last dialog box.

⚠️

This icon denotes a note, which alerts you to important information.

⚠️

This icon denotes a caution, which advises you of precautions to take to avoid injury, data loss, or a system crash. When this symbol is marked on a product, refer to the Safety section of Appendix A, Specifications, for information about precautions to take.

⚠️

When symbol is marked on a product, it denotes a warning advising you to take precautions to avoid electrical shock.

⚠️

When symbol is marked on a product, it denotes a component that may be hot. Touching this component may result in bodily injury.

**bold**

Bold text denotes items that you must select or click in the software, such as menu items and dialog box options. Bold text also denotes parameter names.

*italic*

Italic text denotes variables, emphasis, a cross-reference, or an introduction to a key concept. Italic text also denotes text that is a placeholder for a word or value that you must supply.

*monospace*

Text in this font denotes text or characters that you should enter from the keyboard, sections of code, programming examples, and syntax examples. This font is also used for the proper names of disk drives, paths, directories, programs, subprograms, subroutines, device names, functions, operations, variables, filenames, and extensions.
GPIB Hardware

AT-GPIB/TNT (PnP)

Note  PRINT THIS SECTION! Your computer needs to be off while you install your interface. To print this topic, select File»Print, select the Pages radio button, and print pages 9–10.

Caution  Electrostatic discharge can damage several components on your GPIB board. To avoid such damage in handling your board, touch the antistatic plastic package to a metal part of your computer chassis before removing the board from the package.

Follow these steps to install your interface:

1. Make sure that your computer is powered off. Keep the computer plugged in so that it remains grounded while you install the GPIB hardware.
2. Remove the top cover (or other access panels) to gain access to the computer expansion slots.
3. Find an unused expansion slot in your computer. The AT-GPIB/TNT (PnP) board requires a 16-bit ISA expansion slot.
4. Remove the corresponding slot cover on the back panel of the computer.
5. Insert the GPIB board into the slot with the GPIB connector sticking out of the opening on the back panel, as shown in Figure 1-1. It might be a tight fit, but do not force the board into place.
Figure 1-1. Installing the AT-GPIB/TNT (PnP)

6. Screw the mounting bracket of the GPIB board to the back panel rail of the computer.

7. Replace the top cover (or the access panel to the expansion slot) and power on your computer.

The GPIB hardware installation is now complete.
GPIB-USB Interfaces

1. To install the GPIB-USB interface, connect the USB connector from the GPIB-USB interface to an available USB port on your computer.

2. Before connecting the GPIB-USB interface to GPIB devices, ensure that the computer and the GPIB devices are at the same ground potential. The GPIB-USB interface connects directly to most GPIB devices without requiring a GPIB cable.

3. If your computer is already running, the operating system automatically detects the GPIB interface. Otherwise, the GPIB interface is detected when you start your computer.

![Figure 1-2. Installing the GPIB-USB Interface](image)

**Caution**  The GPIB-USB hardware does not have isolation built into it. If you have a system where there are different ground potentials involved, the voltage difference could surge through the GPIB hardware and cause damage. This situation most often occurs when the PC is a laptop running on a battery and the GPIB device is powered by an AC wall connection.

To prevent damage to the GPIB-USB hardware or other components in your system when different ground potentials are involved, do any of the following:

- Buy a GPIB-120A, which can provide up to 1600 V electrical isolation between GPIB systems. These are available at ni.com.
Buy a pair of GPIB-140A units, which extend a GPIB system using fiberoptics. Because the GPIB signals at each end are transformed into fiberoptic signals, each unit can reside at a different ground potential. These are also available at ni.com.

- Use a USB isolated hub. National Instruments does not sell these, but there are many available for sale elsewhere on the Web or in stores.
- Change the system setup so that all components in the system share the same earth ground to eliminate the possibilities of voltage differential running through the system.

The GPIB hardware installation is now complete.

NI PCIe-GPIB, PCI-GPIB, PCI-GPIB+, PCI-GPIB/LP, and PCI-8232

- Note  PRINT THIS SECTION! Your computer needs to be off while you install your interface. To print this topic, select File»Print, select the Pages radio button, and print pages 12–13.

- Caution  Electrostatic discharge can damage several components on your GPIB board. To avoid such damage in handling your board, touch the antistatic plastic package to a metal part of your computer chassis before removing the board from the package.

Follow these steps to install your interface:

1. Make sure that your computer is powered off. Keep the computer plugged in so that it remains grounded while you install the GPIB hardware.
2. Remove the top cover (or other access panels) to gain access to the computer expansion slots.
3. Find an unused expansion slot in your computer. Your PCI card can be plugged into either a 3.3 V or 5 V, 32- or 64-bit PCI slot. Your NI PCIe-GPIB can be plugged into a x1, x4, x8, or x16 PCI Express slot.
4. Remove the corresponding slot cover on the back panel of the computer.
5. Insert the GPIB board into the slot with the GPIB connector sticking out of the opening on the back panel, as shown in Figure 1-3. It might be a tight fit, but do not force the board into place.

Note Your NI PCIe-GPIB board may be larger than the one shown in the figure.

6. Screw the mounting bracket of the GPIB board to the back panel rail of the computer.

7. Replace the top cover (or the access panel to the expansion slot).

8. Power on your computer.

The GPIB hardware installation is now complete.
PCMCIA-GPIB

Follow these steps to install your interface:

1. Reboot the computer.
2. If the PCMCIA-GPIB is not already inserted, insert it into a free PC Card (PCMCIA) socket. The card has no jumpers or switches to set, and you do not need to power down the system when you insert it.
3. Before connecting the PCMCIA-GPIB interface to GPIB devices, ensure that the computer and the GPIB devices are at the same ground potential.

⚠️ **Caution** The PCMCIA-GPIB hardware does not have isolation built into it. If you have a system where there are different ground potentials involved, the voltage difference could surge through the GPIB hardware and cause damage. This situation most often occurs when the PC is a laptop running on a battery and the GPIB device is powered by an AC wall connection.

To prevent damage to the PCMCIA-GPIB hardware or other components in your system when different ground potentials are involved, do any of the following:

- Buy a GPIB-120A, which can provide up to 1600 V electrical isolation between GPIB systems. These are available at [ni.com](http://ni.com).
- Buy a pair of GPIB-140A units, which extend a GPIB system using fiberoptics. Because the GPIB signals at each end are transformed into fiberoptic signals, each unit can reside at a different ground potential. These are also available at [ni.com](http://ni.com).
- Change the system setup so that all components in the system share the same earth ground to eliminate the possibilities of voltage differential running through the system.
Figure 1-4 shows how to insert the PCMCIA-GPIB and how to connect the cable.

The GPIB hardware installation is now complete.

**NI ExpressCard-GPIB**

1. To install the NI ExpressCard-GPIB interface, plug the card into an available ExpressCard™ slot on your computer.

2. Before connecting the NI ExpressCard-GPIB interface to GPIB devices, ensure that the computer and the GPIB devices are at the same ground potential. The NI ExpressCard-GPIB interface uses the same cable as the PCMCIA-GPIB.

3. If your computer is already running, the operating system automatically detects the GPIB interface. Otherwise, the GPIB interface is detected when you start your computer.
**Caution** The NI ExpressCard-GPIB hardware does not have isolation built into it. If you have a system where there are different ground potentials involved, the voltage difference could surge through the GPIB hardware and cause damage. This situation most often occurs when the PC is a laptop running on a battery and the GPIB device is powered by an AC wall connection.

To prevent damage to the NI ExpressCard-GPIB hardware or other components in your system when different ground potentials are involved, do any of the following:

- Buy a GPIB-120A, which can provide up to 1600 V electrical isolation between GPIB systems. These are available at ni.com.
- Buy a pair of GPIB-140A units, which extend a GPIB system using fiberoptics. Because the GPIB signals at each end are transformed into fiberoptic signals, each unit can reside at a different ground potential. These are also available at ni.com.
- Change the system setup so that all components in the system share the same earth ground to eliminate the possibilities of voltage differential running through the system.

Figure 1-5 shows how to insert the NI ExpressCard-GPIB and connect the cable.

![Figure 1-5. Inserting the NI ExpressCard-GPIB](image)

The GPIB hardware installation is now complete.
PMC-GPIB

Note PRINT THIS SECTION! Your computer needs to be off while you install your interface. To print this topic, select File»Print, select the Pages radio button, and print pages 16–17.

Caution Electrostatic discharge can damage several components on your GPIB board. To avoid electrostatic damage when you handle the board, touch the antistatic plastic package to a metal part of your system chassis before removing the board from the package.

Complete the following steps to install your PMC-GPIB:

1. Power off your system.
2. Find an unused PMC slot in your system. You may need to remove the host from the system to access the PMC slot.
3. Remove the corresponding slot filler panel from the host.
4. Insert the PMC-GPIB into the slot as shown in Figure 1-6. It might be a tight fit, but do not force the board into place.
5. Use the mounting hardware provided to fasten the PMC-GPIB to the host.

6. Reinstall the host, if you removed it to install the PMC-GPIB.

7. Power on your system.

The PMC-GPIB hardware installation is now complete.
Note   PRINT THIS SECTION! Your computer needs to be off while you install your interface. To print this topic, select File»Print, select the Pages radio button, and print pages 18–19.

Caution  Electrostatic discharge can damage several components on your GPIB board. To avoid electrostatic damage when you handle the board, touch the antistatic plastic package to a metal part of your system chassis before removing the board from the package.

Complete the following steps to install your PXI card:

1. Make sure that your PXI or CompactPCI chassis is powered off. Keep the PXI or CompactPCI chassis plugged in so that it remains grounded while you install your PXI card.

2. Choose an unused PXI or CompactPCI 5 V peripheral slot. For maximum performance, your PXI card has an onboard DMA controller that can only be used if the board is installed in a slot that supports bus arbitration, or bus master cards. National Instruments recommends installing your PXI card in such a slot. If you install the board in a non-master slot, you must disable your PXI card’s onboard DMA controller using the board-level call ibdma. Refer to the NI-488.2 Help for a complete description of ibdma.

3. Remove the filler panel for the peripheral slot you have chosen.

4. Touch a metal part on your chassis to discharge any static electricity that might be on your clothes or body.

5. Insert your PXI card into the selected 5 V slot. Use the injector/ejector handle to fully inject the device into place. Figure 1-7 shows how to install your PXI card into a PXI or CompactPCI chassis.
6. Screw the front panel of the PXI card to the front panel mounting rail of the PXI or CompactPCI chassis.

7. Power on your PXI or CompactPCI chassis.

The PXI card installation is now complete.
GPIB-ENET/100 Installation

Follow these steps and refer to Figure 1-8 to install the GPIB-ENET/100:

1. Connect one end of your Ethernet cable to your GPIB-ENET/100. Connect the other end of the Ethernet cable to your Ethernet network.

2. Connect one end of the power cord to the power supply. Screw the power connector on the other end of the power supply onto the power jack of the GPIB-ENET/100.

3. Plug the other end of the power cord into an AC outlet.

4. Refer to the Baseplate Identification Label on the base of the GPIB-ENET/100 and make a note of the serial number, Ethernet address, and default hostname. You will need this information when you run some of the utilities.

5. Contact your network administrator to determine whether your network supports DHCP or if you need to manually perform the Ethernet configuration to set up the network parameters. If your

---

Figure 1-8. Installing the GPIB-ENET/100

<table>
<thead>
<tr>
<th>1</th>
<th>Front Panel LEDs</th>
<th>3</th>
<th>Power Cord</th>
<th>5</th>
<th>Ethernet Connector</th>
<th>7</th>
<th>Ethernet Cable</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>GPIB Cable</td>
<td>4</td>
<td>Power Supply</td>
<td>6</td>
<td>Power Connector</td>
<td>8</td>
<td>To Ethernet Network</td>
</tr>
</tbody>
</table>
network uses DHCP, the network configuration is performed automatically at startup. A steady yellow PWR/RDY LED indicates the GPIB-ENET/100 passed its self-tests and acquired its IP address. The unit is now ready to operate. You may need to run software configuration and verification utilities at this time.

6. Connect the GPIB cable to the GPIB-ENET/100. Connect the other end to your GPIB instrument.

**Baseplate Identification Label**

When you configure the GPIB-ENET/100 for use on your network, you will need to differentiate it from other network devices. Every GPIB-ENET/100 has a unique serial number, Ethernet address, and default hostname. You can find this information on the baseplate identification label on the GPIB-ENET/100.

![Baseplate Identification Label](image)

*Figure 1-9. GPIB-ENET/100 Baseplate Identification Label*

**Note** The Ethernet address is not the IP address. All devices on an Ethernet network are assigned a unique physical address—the Ethernet address—so they can communicate with each other.

**Startup**

Turn on the front-panel power switch. The PWR/RDY LED flickers orange rapidly while the GPIB-ENET/100 completes its power-on self-tests and attempts to acquire its network parameters. Each Ethernet and GPIB LED lights up as its functionality is tested.
By default, the GPIB-ENET/100 attempts its network configuration automatically through DHCP. The time required for assigning the IP address depends on your network and the configuration of your GPIB-ENET/100. Allow up to 90 seconds and observe the state of the PWR/RDY LED to determine the outcome of the self tests. One of the following should occur:

- A steady yellow PWR/RDY LED indicates the GPIB-ENET/100 passed its self tests and acquired its IP address. The unit is now ready to operate. When using DHCP, the GPIB-ENET/100 typically is ready to operate about 15 seconds after you power it on.

- If the PWR/RDY LED continues to flicker orange rapidly, the unit was unable to use DHCP to configure its network parameters. It is now in network configuration mode. Refer to Ethernet Configuration for information on configuring the network parameters manually. If this utility is successful, the PWR/RDY LED should become steady yellow.

- If the PWR/RDY LED blinks a slow red/yellow pattern, the GPIB-ENET/100 did not pass its self tests. Refer to PWR/RDY LED Signaling to interpret the flash pattern before calling National Instruments Technical Support.

- If the PWR/RDY LED is steady red, the GPIB-ENET/100 has an unrecoverable error. Contact National Instruments Technical Support.

Table 1-1 summarizes the functionality of all the front-panel LEDs on the GPIB-ENET/100.

Table 1-1. LED Descriptions

<table>
<thead>
<tr>
<th>LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR/RDY</td>
<td>Flashes orange rapidly at startup while performing self tests and when acquiring network parameters. A steady yellow state indicates the box is ready for operation. A distinct red/yellow flashing pattern indicates an error occurred.</td>
</tr>
<tr>
<td>LINK 10/100</td>
<td>Indicates the GPIB-ENET/100 detected a twisted pair (10Base-T or 100Base-TX) link. The color indicates the connection speed. If yellow, the speed is 10 Mbits/s. If green, the speed is 100 Mbits/s.</td>
</tr>
<tr>
<td>TX</td>
<td>Indicates the GPIB-ENET/100 is transmitting to the Ethernet network.</td>
</tr>
<tr>
<td>RX</td>
<td>Indicates the GPIB-ENET/100 is receiving Ethernet network traffic.</td>
</tr>
<tr>
<td>TALK</td>
<td>Indicates the GPIB-ENET/100 is configured as a GPIB Talker.</td>
</tr>
<tr>
<td>LISTEN</td>
<td>Indicates the GPIB-ENET/100 is configured as a GPIB Listener.</td>
</tr>
</tbody>
</table>
Software Recognition

On Windows, use the Add GPIB-ENET/100 Wizard to add the GPIB-ENET/100 to the NI-488.2 software list of available GPIB interfaces. Launch the Add GPIB-ENET/100 Wizard from Start» Programs»National Instruments»NI-488.2. Accept the GPIB-ENET/100 default configuration settings or change them while running the Wizard. Once the GPIB-ENET/100 is recognized in Measurement & Automation Explorer, you may need to remove it and add it again after using the NI Ethernet Device Configuration Utility to change the configuration settings.

On Mac and Linux, use the Add GPIB Hardware Wizard to add the GPIB-ENET/100 to the NI-488.2 software list of available GPIB interfaces. Launch the Add GPIB Hardware Wizard from the GPIB Explorer utility in the installed NI-488.2 or ni4882 directory. Once the GPIB-ENET/100 is recognized, you can change the configuration settings with the NI Ethernet Device Configuration Utility, described in the Ethernet Configuration section.

Refer to the installation guide on your CD for more details about the Add GPIB-ENET/100 Wizard, Add GPIB Hardware Wizard, and GPIB Explorer utility.

Ethernet Configuration

Use the NI Ethernet Device Configuration utility if you need to manually configure the network parameters of the GPIB-ENET/100. If your network uses DHCP, the network configuration is performed automatically at startup, and you do not need to run this utility unless you want to change the hostname. Consult your network administrator if you do not know whether your network uses DHCP.

In addition to manually configuring the network parameters, you can use the NI Ethernet Device Configuration utility for any of the following purposes:

- Enable DHCP
- Verify or change the hostname
- Add or change a comment to help identify the device

On Windows, once the GPIB-ENET/100 is recognized in Measurement & Automation Explorer, you may need to remove it and add it again after using the NI Ethernet Device Configuration Utility to change the configuration settings.
Using the NI Ethernet Device Configuration Utility

The GPIB-ENET/100 must be in network configuration mode—the PWR/RDY LED continuously flickers orange rapidly—before you can make changes to the network parameters. The GPIB-ENET/100 automatically enters network configuration mode if it is unable to obtain its network configuration through DHCP. During normal operation, you also can enter network configuration mode by pressing and holding the rear-panel CFG RESET switch for three seconds.

Run the NI Ethernet Device Configuration Utility. For Windows, select Start>Programs>National Instruments>Measurement & Automation to launch Measurement & Automation Explorer. Select Help>Help Topics>NI-488.2 to view the NI-488.2 online help. Search for the topic Set Network Settings for the GPIB-ENET/100 and click the link to launch the utility.

If you are using a Mac, Linux, or UNIX platform, launch the utility from the GPIB Explorer utility in the installed NI-488.2 or ni4882 directory.

The NI Ethernet Device Configuration window displays a list of National Instruments Ethernet devices found on your subnet, sorted by model. You can identify your device by the Ethernet address or the serial number found on the GPIB-ENET/100 baseplate label.

The listed devices can be in one of four possible states, as indicated in the IP address/hostname column:

- A hostname indicates the device has successfully been configured by DHCP.
- A numerical IP address indicates the device has successfully been configured with a static IP address.
- *Unconfigured* indicates the device is configured to use DHCP, but DHCP failed to attain network parameters.
- *Busy* indicates the device is configured to use DHCP and currently is attempting to acquire network parameters.

View the properties for any of the following reasons:

- You need to configure an unconfigured IP address.
- You need to change the current network parameters.
- You previously used DHCP, but it is no longer available.
- You are using DHCP and need to change the hostname of the GPIB-ENET/100.
The IP address/hostname column displays an exclamation point (!) next to your GPIB-ENET/100, indicating a configuration problem. Refer to Verifying the Hostname for help resolving this problem.

You want to add or change a comment to help identify the device.

Refresh the list of Ethernet devices if you do not see your GPIB-ENET/100 in the list, or to discover a device that you recently added to the subnet.

Exit if you are finished using the NI Ethernet Device Configuration utility or if you are using DHCP and you do not need to change the hostname of the GPIB-ENET/100.

Changing the Network Settings

Your GPIB-ENET/100 must be in network configuration mode before you can use the NI Ethernet Device Configuration utility to change its network settings. You also can refer to Enter Network Configuration Mode during Normal Operation if the PWR/RDY LED is not currently flickering orange rapidly.

1. View the properties for your GPIB-ENET/100.
   The current hostname is displayed. The hostname associates a name with a numerical IP address. Hostname is a required field.
   The GPIB-ENET/100 attempts to use the hostname when registering with DHCP. Many DHCP servers have the ability to register the hostname and the assigned IP address. You then can reliably use the hostname to communicate with your GPIB-ENET/100 even if the numerical IP address changes.
   However, some DHCP servers do not implement hostname registration. The GPIB-ENET/100 requires Domain Name Server (DNS) registration when using DHCP. If your DHCP server does not support DNS registration, you must use static network parameters.

2. Select either Obtain an IP address automatically (DHCP) or Use the following IP settings.
   a. If you select Obtain an IP address automatically (DHCP), you do not need to enter any network parameters unless you want to change the hostname of the Ethernet device.
   b. If you select Use the following IP settings, enter the Static IP Parameters you have chosen for the host IP address, subnet mask, gateway IP, and DNS server IP.
3. You can enter an optional comment to help you identify each device.
4. Confirm your changes and exit the NI Ethernet Device Configuration utility.

The GPIB-ENET/100 automatically reboots with the new configuration in effect.

**Static IP Parameters**

If DHCP is not available, you must provide the GPIB-ENET/100 with several important network parameters.

- **IP address**—The unique, computer-readable address of a device on your network. An IP address typically is represented as four decimal numbers separated by periods (for example, 130.164.54.215). Refer to the *Choosing a Static IP Address* section.

- **Subnet mask**—A code that helps the network device determine whether another device is on the same network or a different network.

- **Gateway IP**—The IP address of a device that acts as a gateway, which is a connection between two networks. If your network does not have a gateway, set this parameter to 0.0.0.0.

- **DNS Server**—The IP address of a network device that stores hostnames and translates them into IP addresses. If your network does not have a DNS server, set this parameter to 0.0.0.0.

**Choosing a Static IP Address**

*For a Network Administered by a Network Administrator*

If you are adding the GPIB-ENET/100 to an existing Ethernet network, you must choose IP addresses carefully. Contact your network administrator to obtain an appropriate static IP address for your GPIB-ENET/100. Also have the network administrator assign the proper subnet mask, gateway, and DNS server addresses.

*For a Network without a Network Administrator*

If you are assembling your own small Ethernet network, you can choose your own IP addresses. The format of the IP addresses is determined by the subnet mask. You should use the same subnet mask as the computer you are using with your GPIB-ENET/100. If your subnet mask is 255.255.255.0, the first three numbers in every IP address on the network must be the same. If your subnet mask is 255.255.0.0, only the first two numbers in the IP addresses on the network must match.
For either subnet mask, numbers between 1 and 254 are valid choices for the last number of the IP address. Numbers between 0 and 255 are valid for the third number of the IP address, but this number must be the same as other devices on your network if your subnet mask is 255.255.255.0.

If you are setting up your own network, you probably do not have a gateway or DNS server, so you should set these values to 0.0.0.0.

**Verifying the Hostname**

The NI Ethernet Device Configuration utility automatically verifies that the hostname for each DHCP-enabled device matches the DNS entry for the assigned IP address. This verification process automatically occurs when you either run the utility or refresh the list of devices. The utility alerts you if it detects a problem with the network settings.

To correct the problem with the hostname, complete the following steps:

1. Locate the device that has a problem. This is indicated by an exclamation point (!) on the device icon.
2. View the properties for the device. The utility displays four options for resolving the verification error. Select the one that best fits your situation.
   - **Change the device’s hostname to match the DNS entry**—Use this option if you want to accept the hostname assigned by the DHCP server, or if you cannot contact the network administrator to change the DNS entry.
   - **Use static network parameters instead of DHCP**—Use this option if you cannot use the hostname assigned by the DHCP server. Contact your network administrator to obtain a valid IP address, subnet, and gateway. This option disables DHCP on the device.
   - **Edit the current hostname**—Use this option to change the hostname to a name other than either the configured hostname or the name assigned by the DHCP server. Contact your network administrator to obtain a valid name.
   - **Keep the existing hostname**—Use this option if you want to keep the previously assigned hostname. If you select this option, contact your network administrator to change the DNS entry.
3. Confirm the network parameter settings. The device reboots with the new settings in effect.
4. After the device reboots, refresh the list of devices to verify that the hostname is now valid.

5. Exit when you are finished using the NI Ethernet Device Configuration utility.

**Firmware Update**

The GPIB-ENET/100 software includes a firmware update utility you can use to access new features that may be added to the GPIB-ENET/100 in the future. You must update the firmware to take advantage of any new features.

The GPIB-ENET/100 always ships with the most recent firmware. You do not need to run the firmware update utility on a new product. You can obtain the latest upgrade at the following path:


You need to know either the IP address or hostname of your GPIB-ENET/100 before you run the NI Ethernet Device Firmware Update utility. If you do not remember this information, first run the NI Ethernet Device Configuration utility.

**Caution**  
Do not power-off the GPIB-ENET/100 or disconnect the power supply while running the NI Ethernet Device Firmware Update utility. Doing so will damage the unit. The GPIB-ENET/100 reboots automatically when the update completes.

**Note**  
The NI Ethernet Device Firmware Update utility cannot update the firmware while any network connections are active. Close any open connections before you attempt a firmware update. Hosts cannot connect to the GPIB-ENET/100 while it is updating the firmware.

1. In Windows, run Measurement & Automation Explorer. Right-click on any GPIB-ENET/100 interface and select **Firmware Update** from the drop-down menu. If you are using a Mac, Linux, or UNIX platform, launch the utility from the GPIB Explorer utility in the installed NI-488.2 or ni4882 directory.

2. Specify the hostname or IP address of the GPIB-ENET/100 and enter the full path of the binary file where the firmware image is located.

3. The NI Ethernet Device Firmware Update utility communicates with the specified GPIB-ENET/100 to verify the box has no open network connections and determine the current version of the firmware in the unit.
4. When prompted, confirm the change you are about to perform. The update utility transfers the firmware image to your GPIB-ENET/100 and displays the status of the update, including whether the firmware update completed successfully or failed. The GPIB-ENET/100 automatically reboots with the new firmware in effect.

5. Exit the NI Ethernet Device Firmware Update utility.

**PWR/RDY LED Signaling**

The PWR/RDY LED blinks slowly in a distinct red/yellow pattern to alert you of internal errors. Use this section to interpret and record the pattern that the PWR/RDY LED flashes, and then contact National Instruments.

**Note** By recording the PWR/RDY LED status messages before calling National Instruments, you can save yourself time, and the Product Support Department can answer your questions more accurately and efficiently. Do not switch off power to your GPIB-ENET/100 before recording the flashing PWR/RDY LED pattern.

PWR/RDY LED signaling can report up to 81 different errors. The errors are numbered from 11 to 99 and are reported through sequences of PWR/RDY LED flashes.

**Note** There is no zero in any error message. This means that error message numbers 0–10, 20, 30, 40, 50, 60, 70, 80, and 90 are not possible.

**Step 1. Count the Long Flashes**

A three-second interval, during which the PWR/RDY LED is yellow, separates each repetition of the sequence. The sequence begins with a series of long one-second flashes—that is, one second red, one second yellow. These long flashes represent the digit in the tens column. There can be one to nine long flashes, which represent digits 1 through 9. For example, one long flash represents the digit 1 in the tens column, and nine long flashes represent the digit 9 in the tens column.

**Step 2. Count the Short Flashes**

The long flashes are followed by shorter flashes; each short flash lasts about one-fifth of a second—that is, one-fifth of a second red, one-fifth of a second yellow. These short flashes represent the digit in the ones column. Again, there can be one to nine flashes, which represent the digits 1 through 9. For example, one short flash represents the digit 1 in the ones column, and nine short flashes represent the digit 9 in the ones column.
Using this method, the **PWR/RDY** LED flashes the following sequence to represent status message 11:

<three seconds yellow> <one long red flash> <one short red flash> <three seconds yellow>…

The **PWR/RDY** LED flashes the following sequence to represent status message 31:

<three seconds yellow> <three long red flashes> <one short red flash> <three seconds yellow>…

### Step 3. Record Your Status Code Number

When you have computed your error message number, write it down and also note the ON/OFF state of the **LINK**, **TX**, and **RX** LEDs. Have this information available when calling National Instruments.

### CFG RESET Switch

The Configuration Reset (CFG RESET) switch is a recessed switch located beside the ENET connector on the rear panel.

You can use this switch to either reset the unit to its default network characteristics or place the GPIB-ENET/100 in network configuration mode.

### Reset the Default Network Characteristics at Startup

If you want to reset the unit to its default network characteristics, you can use the CFG RESET switch at power-on. By pressing and holding the CFG RESET switch while you power on the GPIB-ENET/100, the network parameters revert to the default settings as defined on the baseplate label.

You must press and hold the switch for three seconds. If you release the switch prior to three seconds, no change occurs to the network configuration, and the GPIB-ENET/100 continues to boot normally.

Observe the **PWR/RDY** LED as it goes through the following changes during these three seconds.

1. The LED begins slowly alternating between red and yellow.
2. The alternating pattern increases in tempo.
3. At three seconds, the **PWR/RDY** LED becomes steady red. This indicates the network configuration will be set to the factory default settings.

4. When you release the CFG RESET switch, the box continues to boot as normal, and the **PWR/RDY** LED indicates the boot process as described in Table 1-1, *LED Descriptions*.

### Enter Network Configuration Mode during Normal Operation

While the GPIB-ENET/100 is operational, as indicated by a steady yellow **PWR/RDY** LED, you can use the CFG RESET switch to place the box into network configuration mode. You then can use the NI Ethernet Device Configuration utility.

Because you cannot change the network parameters unless you deliberately place the GPIB-ENET/100 into network configuration mode, the parameters are protected while in normal operation. Hosts cannot connect to the GPIB-ENET/100 while it is in network configuration mode.

**Note** Pressing the CFG RESET switch has no effect if hosts are currently connected.

Close all connections, then press and hold the CFG RESET switch for three seconds. If you release the switch prior to three seconds, the GPIB-ENET/100 continues to operate normally.

The **PWR/RDY** LED goes through the following changes during these three seconds.

1. The LED begins slowly alternating between red and yellow.
2. The alternating pattern increases in tempo.
3. At three seconds, the **PWR/RDY** LED becomes steady red. This indicates the GPIB-ENET/100 is ready to enter network configuration mode.
4. Now release the CFG RESET switch. The **PWR/RDY** LED alternates rapidly between red and yellow to indicate the GPIB-ENET/100 is now in network configuration mode.

This mode remains in effect until you switch off the GPIB-ENET/100 or you use the NI Ethernet Device Configuration utility to change its network characteristics. The GPIB-ENET/100 automatically reboots when you exit the utility.
Specifications

AT-GPIB/TNT (PnP), GPIB-USB Interfaces, PCI-8232, NI PCIe-GPIB (Part Number 198405x-0xL), PCI-GPIB, PCI-GPIB+, PCMCIA-GPIB, PMC-GPIB

Environment

Operating ambient temperature.............. 0 to 55 °C
Operating relative humidity .................. 10 to 90%, noncondensing

Storage environment
  Storage ambient
temperature ..................................... −20 to 70 °C
  Storage relative
humidity ........................................ 5 to 95%, noncondensing
(Tested in accordance with
IEC-60068-2-1, IEC-60068-2-2,
and IEC-60068-2-56.)

Power Requirements

AT-GPIB/TNT (PnP)............................ +5 VDC @ 120 mA typical,
                                           240 mA max

GPIB-USB Interfaces......................... Bus Power @ 500 mA max

PCI-8232 ......................................... +5 VDC @ 874 mA typical,
                                           1160 mA max

NI PCIe-GPIB (part number
198405x-0xL)................................. +3.3 VDC @ 320 mA typical,
                                           500 mA max
Appendix A Specifications

PCI-GPIB (with TNT4882C controller) ...............................................+3.3 VDC @ 121 mA typical, 182 mA max  
+5 VDC @ 300 mA typical, 450 mA max

PCI-GPIB (with TNT5004 controller) ...............................................+5 VDC @ 150 mA max +VIO @ 5 mA max

PCI-GPIB+ .............................................+3.3 VDC @ 170 mA typical, 575 mA max

PCMCIA-GPIB ......................................+5 VDC @ 65 mA typical, 85 mA max

PMC-GPIB .............................................+5 VDC @ 50 mA typical, 100 mA max

Performance

AT-GPIB/TNT (PNP)
3-wire...............................................Up to 1480 Kbytes/s
HS488 ...............................................Up to 1580 Kbytes/s

GPIB-USB-B
3-wire...............................................Up to 930 Kbytes/s
HS488 ...............................................Up to 930 Kbytes/s

GPIB-USB-HS
3-wire...............................................Up to 1800 Kbytes/s
HS488 ...............................................Up to 7820 Kbytes/s

NI PCIe-GPIB (198405x-0xL)
3-wire...............................................Up to 1670 Kbytes/s
HS488 ...............................................Up to 7980 Kbytes/s

PCI-GPIB
3-wire...............................................Up to 1620 Kbytes/s
HS488 ...............................................Up to 7980 Kbytes/s
Appendix A  Specifications

PCMCIA-GPIB

3-wire .............................................. Up to 1350 Kbytes/s
HS488 ............................................. Up to 1350 Kbytes/s

**PXI-8232, PXI-GPIB**

**Environment**

Operating ambient temperature ........... 0 to 55 °C
Operating relative humidity ............... 10 to 90%, noncondensing
Storage ambient temperature .............. –20 to 70 °C
Storage relative humidity ................... 5 to 95%, noncondensing
(Tested in accordance with IEC-60068-2-1, IEC-60068-2-2, and IEC-60068-2-56.)

**Shock and Vibration**

Functional shock .............................. 30 g peak, half-sine, 11 ms pulse
(Tested in accordance with IEC-60068-2-27. Test profile developed in accordance with MIL-PRF-28800F.)

Random vibration

Operating ................................. 5 to 500 Hz, 0.3 g<sub>rms</sub>
Nonoperating ............................. 5 to 500 Hz, 2.4 g<sub>rms</sub>
(Tested in accordance with IEC-60068-2-64. Nonoperating test profile exceeds the requirements of MIL-PRF-28800F, Class 3.)
## Power Requirements

<table>
<thead>
<tr>
<th>Device</th>
<th>Power Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>PXI-8232</td>
<td>+3.3 VDC @ 910 mA typical, 1,500 mA max</td>
</tr>
<tr>
<td>PXI-GPIB (with TNT4882C controller)</td>
<td>+3.3 VDC @ 122 mA typical, 182 mA max, +5 VDC @ 300 mA typical, 450 mA max</td>
</tr>
<tr>
<td>PXI-GPIB (with TNT5004 controller)</td>
<td>+3.3 VDC @ 80 mA typical, 165 mA max, +VIO @ 3 mA typical, 10 mA max</td>
</tr>
</tbody>
</table>

## Performance

- **GPIB**
  - 3-wire: Up to 1620 Kbytes/s
  - HS488: Up to 7980 Kbytes/s

## NI PCIe-GPIB (Part Number 190243x-01)

### Environment

- **Operating ambient temperature**: 0 to 35 °C
- **Operating relative humidity**: 10 to 90%, noncondensing
- **Storage ambient temperature**: -20 to 70 °C
- **Storage relative humidity**: 5 to 95%, noncondensing (Tested in accordance with IEC-60068-2-1, IEC-60068-2-2, and IEC-60068-2-56.)
- **Power requirements**: +3.3 VDC @ 970 mA typical, +12 VDC @ 124 mA typical
Performance

GPIB

3-wire .............................................. Up to 1610 Kbytes/s
HS488 ............................................. Up to 7960 Kbytes/s

GPIB-ENET/100

Environment

Operating ambient temperature.............. 0 to 65 °C
Operating relative humidity ................. 10 to 90%, noncondensing
Storage ambient temperature ................. –40 to 100 °C
Storage relative humidity ...................... 5 to 95%, noncondensing
(Tested in accordance with IEC-60068-2-1, IEC-60068-2-2, and IEC-60068-2-56.)

Power requirements................................. External source 9 to 30 VDC
+15 VDC @ 250 mA typical, 425 mA max

Performance

GPIB

3-wire .............................................. Up to 1000 Kbytes/s
HS488 ............................................. Up to 1410 Kbytes/s

NI ExpressCard-GPIB

Environment

Operating ambient temperature.............. 0 to 65 °C
Operating relative humidity ................. 5 to 95%, noncondensing
Storage ambient temperature ................. –20 to 65 °C
(Tested in accordance with IEC-60068-2-1, IEC-60068-2-2, and IEC-60068-2-56.)
Nonoperating thermal shock ................. –20 to 65 °C, 5 shocks
Shock and Vibration

Nonoperating shock ...........................................50 g, 11 ms
( Tested in accordance with IEC 60068-2-27.)

Nonoperating vibration, sinusoidal ................................15 g, 100 to 2,000 Hz
( Tested in accordance with IEC 60068-2-6.)

Nonoperating drop test ....................................2 drops in 3 mutually exclusive axes from 75 cm onto no-cushioning vinyl tile surface

Power requirements ........................................+3.3 VDC ± 10% @ 140 mA typical, 500 mA max

Performance

GPIB
3-wire ...................................................... Up to 1830 Kbytes/s
HS488 ....................................................... Up to 7230 Kbytes/s

All Devices

Altitude ..............................................................2,000 m (at 25 °C ambient temperature)

Pollution Degree .............................................. 2

Indoor use only

Safety

This product is designed to meet the requirements of the following standards of safety for electrical equipment for measurement, control, and laboratory use:

• IEC 60950-1, EN 60950-1
• UL 60950-1, CSA 60950-1

Note For UL and other safety certifications, refer to the product label or visit ni.com/certification, search by model number or product line, and click the appropriate link in the Certification column.
Note The protection provided by this equipment may be impaired if it is used in a manner not described in this document.

Electromagnetic Compatibility

This product is designed to meet the requirements of the following standards of EMC for electrical equipment for measurement, control, and laboratory use:

- EN 61326 EMC requirements; Minimum Immunity
- EN 55011 Emissions; Group 1, Class A
- CE, C-Tick, ICES, and FCC Part 15 Emissions; Class A

Note For EMC compliance, operate this device with shielded cabling.

CE Compliance

This product meets the essential requirements of applicable European Directives, as amended for CE marking, as follows:

- 2006/95/EC; Low-Voltage Directive (safety)
- 2004/108/EC; Electromagnetic Compatibility Directive (EMC)

Note Refer to the Declaration of Conformity (DoC) for this product for any additional regulatory compliance information. To obtain the DoC for this product, visit ni.com/certification, search by model number or product line, and click the appropriate link in the Certification column.

Environmental Management

NI is committed to designing and manufacturing products in an environmentally responsible manner. NI recognizes that eliminating certain hazardous substances from our products is beneficial not only to the environment but also to NI customers.

For additional environmental information, refer to the NI and the Environment Web page at ni.com/environment. This page contains the environmental and directives with which NI complies, as well as other environmental information not included in this document.
Waste Electrical and Electronic Equipment (WEEE)

EU Customers  At the end of their life cycle, all products must be sent to a WEEE recycling center. For more information about WEEE recycling centers and National Instruments WEEE initiatives, visit ni.com/environment/weee.htm.

电子信息产品污染控制管理办法（中国RoHS）

中国客户  National Instruments 符合中国电子信息产品中限制使用某些有害物质指令 (RoHS)。关于 National Instruments 中国 RoHS 合规性信息，请登录 ni.com/environment/rohs_china。 (For information about China RoHS compliance, go to ni.com/environment/rohs_china.)
Visit the following sections of the award-winning National Instruments Web site at ni.com for technical support and professional services:

- **Support**—Technical support resources at [ni.com/support](http://ni.com/support) include the following:
  - **Self-Help Technical Resources**—For answers and solutions, visit [ni.com/support](http://ni.com/support) for software drivers and updates, a searchable KnowledgeBase, product manuals, step-by-step troubleshooting wizards, thousands of example programs, tutorials, application notes, instrument drivers, and so on. Registered users also receive access to the NI Discussion Forums at [ni.com/forums](http://ni.com/forums). NI Applications Engineers make sure every question submitted online receives an answer.
  - **Standard Service Program Membership**—This program entitles members to direct access to NI Applications Engineers via phone and email for one-to-one technical support as well as exclusive access to on demand training modules via the Services Resource Center. NI offers complementary membership for a full year after purchase, after which you may renew to continue your benefits.

  For information about other technical support options in your area, visit [ni.com/services](http://ni.com/services), or contact your local office at [ni.com/contact](http://ni.com/contact).

- **Training and Certification**—Visit [ni.com/training](http://ni.com/training) for self-paced training, eLearning virtual classrooms, interactive CDs, and Certification program information. You also can register for instructor-led, hands-on courses at locations around the world.

- **System Integration**—If you have time constraints, limited in-house technical resources, or other project challenges, National Instruments Alliance Partner members can help. To learn more, call your local NI office or visit [ni.com/alliance](http://ni.com/alliance).
If you searched ni.com and could not find the answers you need, contact your local office or NI corporate headquarters. Phone numbers for our worldwide offices are listed at the front of this manual. You also can visit the Worldwide Offices section of ni.com/niglobal to access the branch office Web sites, which provide up-to-date contact information, support phone numbers, email addresses, and current events.